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1. การเขา้สูโ่ปรแกรม  

• ระบ ุuser/passwod แลก้ดปุ่ ม Login 
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• ระบบแสดง Responsibility และ Worklist (ซึง่ Worklist มปีระโยชนก์รณีทีเ่ป็นผูบั้นทกึใบขอซือ้หรอืใบสัง่ซือ้ว่ามี
การอนุมัตมิาแลว้ ถา้กรณีเป็นผูอ้นุมัต ิsing on เขา้มาเป็น Worklist ทีแ่สดงวา่มเีลขทีใ่บขอซือ้หรอืใบสัง่ซือ้ใดสง่

มาเพือ่ใหอ้นุมัต ิผูอ้นุมัตก็ิดับเบิล้คลิ๊กเขา้ไป เพือ่เปิดเอกสารแลว้ท าการอนุมัตไิดเ้ลย) 

 

 
 

• Double Click Responsibility SQ1 สว่นบรหิารกจิการสยามสแควรวั์น PR USER 
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• ระบบแสดงเมนูย่อยของ Responsibility นัน้ 

 

 
 

• Double Click เมนูย่อย เพือ่เขา้หนา้จอ 

• ระบบจะเขา้สูห่นา้จอ Security Warning 

• ระบบจะขึน้หนา้จอ Do you want to run this application  
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• ใหก้ดที ่Check Box  แลว้กดปุ่ ม  

 

 
 

• ระบบจะเขา้สูห่นา้จอท างาน แลว้กดปิด X หนา้จอไปกอ่น เพือ่กลับไปทีเ่มนูหลัก 
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• เมนูหลัก เลอืกเขา้เมนูการใชง้านตอ่ไป 
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2. Requisition (การออกใบขอซือ้) กรณี BU Vat Requisitions 

 
Oracle Menu Path: (N) → Requisitions → BU Vat Requisitions (B) Open  

 

วตัถปุระสงค ์ 
 

เป็นหนา้จอในการออกใบขอซือ้กรณีทีม่ ีVat ซึง่เป็นหนา้จอทีม่กีาร Custom เดมิ เพือ่ใชใ้นการออกใบขอซือ้ได ้

 
 

Requisitions Windows 
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1. Requisition Header Zone 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Operating 
Unit 

ระบบจะแสดงขอ้มลูของ Operating 
Unit ตาม Responsibility ทีใ่ชง้าน 

* ไมต่อ้งแกไ้ขใชค้่า Default ที่
ระบบแสดง 

2 Number ระบเุลขทีข่อง Requisition ระบบจะให ้

เลขที ่หลังจากมกีารบันทกึขอ้มลูและ
ท าการ Save แลว้ 

* ปัจจุบันมกีารSetup ใหร้ะบบท า

การ Generate Requisition 
Number ใหเ้ป็นแบบอัตโนมัต ิ 

3 Type Purchase Requisition  เป็นใบแสดง
ความตอ้งการซือ้จาก supplier  

*  

4 Preparer เป็นชือ่พนักงานทีจั่ดท า Requisition 

ทีผู่กกับ User Logon ซึง่ระบบจะ
แสดงใหอั้ตโนมัต ิไมส่ามารถแกไ้ขได ้

*  

5 Description ใสร่ายละเอยีดของใบขอซือ้ไดต้าม

ตอ้งการ ระบุได ้250 ตัวอักษร 
เพือ่ประโยชนใ์นการ Group ขอ้มลู

แสดงในรายงาน CUP BG02 GROUP 

History for PR 

*  

6 Status เป็นการแสดงสถานะของ Requisition 

ซึง่ระบบจะแสดง  Status ครัง้แรกเป็น 
Incomplete  

-   Incomplete: เป็นสถานะเริม่แรก 

-   In Process: หมายถงึเอกสารอยู่
ในระหวา่งทีส่ง่ไปใหผู้ม้อี านาจอนุมัติ

ท าการอนุมัต ิ
-   Approve, Reserved: หมายถงึ

เอกสารไดผ้่านการอนุมัตแิลว้และจอง

งบประมาณ (Budget) แลว้ 
-   Reject: หมายถงึเอกสารไดถ้กู

ผูอ้นุมัตติคีนืกลับมา ซึง่ผูใ้ชจ้ะตอ้ง
แกไ้ขใหมแ่ลว้สง่ใหอ้นุมัตใิหม่อกีครัง้ 

-  Return: หมายถงึใบขอซือ้นี้ไดถ้กู 
Return จากผูจั้ดท าใบสัง่ซือ้ในระบบ 

ใหก้ลับมาท าการแกไ้ขใหมแ่ลว้สง่ให ้

ผูอ้นุมัตใิหม่อกีครัง้ เมือ่ผ่านการอนุมัติ

* 
 

Incomplete: เป็นสถานะ

เริม่แรก 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

เพือ่สามารถน ามาจัดท าเป็นใบสัง่ซือ้  
- Cancelled: หมายถงึ ใบขอซือ้นี้ได ้

ถกูยกเลกิ        

7 Total เป็นยอดเงนิรวมทัง้หมดของใบขอซือ้
ซึง่ระบบจะ Update ใหอั้ตโนมัต ิ

* 
 

 

8 Descriptive 
Flexfield 

ใหร้ะบขุอ้มลูเพิม่เตมิ โดยมขีอ้มลูที่
ตอ้งระบดุังนี้ 

- วันทีข่องเอกสาร (วันทีใ่บเสนอราคา) 

- ใชจ่้ายจากงบปี 
- จัดซือ้จัดจา้งจาก 

- ก าหนดแลว้เสร็จ (วัน) 
- วธิกีารซือ้/จา้ง 

- ค าอธบิายประกอบ 

- ประธานกรรมการตรวจรับ 
- กรรมการและเลขานุการ 

- กรรมการตรวจรับ 1 
- กรรมการตรวจรับ 2 

- กรรมการตรวจรับ 3 

- กรรมการตรวจรับ 4 
- กรรมการตรวจรับ 5 

- กรรมการตรวจรับ 6 
- กรรมการตรวจรับ 7 

* 
 

 

 

 
2. Requisition Lines Zone 

 
บนัทกึขอ้มลูดงันี ้

 

Lines Tab Region 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Num Line บรรทัด ระบบจะสรา้งใหอั้ตโนมัต ิ *  

2 Type ระบบจะแสดงใหอั้ตโนมัต ิเป็น Good *  

3 Item บันทกึสนิคา้ทีต่อ้งการขอซือ้ตาม

ตอ้งการโดยเลอืกจาก List of Value 
วธิกีารเลอืก Item ใส ่% แลว้กดปุ่ ม 

OK หรอืถา้รูว้า่ Item นี้ข ึน้ตน้ดว้ย 04 ก็

สามารถระบุ 04% แลว้กดปุ่ ม OK 
เพือ่ใหร้ะบบแสดง Item ใหเ้ลอืกใส ่

* 

 

Item ขึน้ตน้ดว้ย 

01% ซือ้ Asset 
04% ซือ้ Inventory 

05% ซือ้ Expense 

4 Revision   เป็น Revision ของ Item   

5 Category ระบบจะแสดง Category ของ Item  * 
 

 

6 Description ระบบแสดงตาม Description ตาม 
Item ทีก่ าหนด แลว้ท าการแกไ้ขกรณี

ที ่Description ไมต่รงกับความตอ้งการ 

* 
 

 

7 UOM หน่วยนับ *  

8 Quantity 
 

บันทกึจ านวนสนิคา้ทีต่อ้งการขอซือ้ 
 

* 
 

 

9 Price ระบรุาคาต่อหน่วยของสนิคา้ Line นัน้
ยังไมร่วม Vat  

*  

10 Price Inc Vat ระบบแสดงราคาตอ่หน่วยของสนิคา้ 

Line นัน้ตาม Price ใหอั้ตโนมัตกิอ่น 
หลังจากทีม่กีารระบ ุVat Code แลว้กด

ปุ่ ม Calculate แลว้ระบบจะเปลีย่นคา่
ใหเ้ป็น Price + Vat Line นัน้ 

* 
 

 

11 Need By  Date ใสวั่นทีต่อ้งการสนิคา้   

12 Amount ระบบจะท าการค านวณใหอั้ตโนมัต ิ

โดยน า Quantity คณูกับ Price 

* 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

13 Destination 
Type 

ระบบจะแสดงตาม Item ทีเ่ลอืกให ้
โดยอัตโนมัตเิป็น Expense หรอื 

Inventory 

* Item ขึน้ตน้ดว้ย 
01% เป็น Expense 

04% เป็น Inventory 
05% เป็น Expense 

14 Requestor ระบบจะแสดงใหเ้ป็น Default ตาม 

Employee ทีไ่ดผ้กูไวกั้บ User Log 
on ให ้

*  

15 Organization บันทกึ Organization ทีท่ าการขอซือ้

สนิคา้ 

*  

16 Location บันทกึสถานทีท่ีต่อ้งการใหส้ง่สนิคา้ 

(Location ของ Organization) 

*  

17 Subinventory  ถา้ตอ้งการระบุ Subinventory ทีจ่ะท า
การรับของ 

  

18 Source ระบบจะแสดงใหอั้ตโนมัต ิเป็น 

Supplier 

*  

19 Supplier ถา้มกีารก าหนด Setup Sourcing 

Rule  ระบบจะแสดง Supplier ให ้
ทันทเีมือ่มกีารเลอืก Item หรอืบันทกึ

ชือ่ Supplier ทีจ่ะท าการสัง่ซือ้สนิคา้  

 ไมต่อ้งใสท่ี ่PR ไปใสต่อนสรา้ง 

PO 

20 Site ตอ้งบันทกึ Supplier Site (ถา้มกีาร
ระบชุือ่ Supplier)  เพราะว่าถา้ไมร่ะบ ุ

Supplier Site เมือ่มกีารน าใบขอซือ้ 

ไปท าการ Auto Create เป็น PO 
ระบบจะไม่แสดงชือ่ Supplier ใน

 ไมต่อ้งใสท่ี ่PR ไปใสต่อนสรา้ง 
PO 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

หนา้จอ PO ให ้

 

 

Source Details Tab Region 
 

 
 

 

     
 

ล าดบั ชือ่ฟิลด ์  ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

21 Note to 
Buyer  

 บันทกึ Note to Buyer หาก
ตอ้งการแจง้อะไรใหผู้จ้ัดท า

ใบสัง่ซือ้ทราบ 

  

22 Buyer  ถา้มกีารระบุชือ่ Buyer (ซึง่
จะเป็นชือ่ของพนักงาน) 

แสดงวา่ตอ้งการใหช้ือ่นี้
จัดท าใบสัง่ซือ้สนิคา้ให ้  

  

 

 
3. Requisition Distribution Zone 

 
Oracle Menu Path: (N) → Requistiions → Requisitions → (B) Distributions 

 
จากหนา้จอ Requisition Click ทีปุ่่ ม Distributions เพือ่บันทกึ Charge Account ทีจ่ะบันทกึบัญช ี
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

23 Num ระบบแสดงบรรทัดที ่ *  

24 Quantity ระบบแสดงอัตโนมัต ิ *  

25 Charge ระบบจะท าการ Generate Account ที่ *  
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

Account จะบันทกึบัญชใีหอั้ตโนมัต ิตามทีม่กีาร
สรา้งมาจาก Item ซึง่บัญชนีี้จะเป็น

บัญชทีีจ่ะไปตัดงบประมาณ (Budget) 
ในระบบ  

 

หมายเหต:ุ กรณีที ่Item ขึน้ตน้ดว้ย 
04 ซึง่เป็น Item ทีเ่ป็นรหัสสนิคา้ – 

ระบบจะท าการลงบัญชใีหอั้ตโนมัต ิ
สว่นกรณีทีเ่ป็น Item ประเภทอืน่ๆ ทาง

ผูบั้นทกึจะตอ้งมกีารแกไ้ขบัญชตีามที่

ไดข้อจากแผนกบัญชมีาใหถู้กตอ้ง 

26 GL Date วันทีท่ีเ่กดิรายการบัญช ีซึง่วันทีท่ี่

สามารถระบุไดจ้ะตอ้งเป็นวันทีใ่นงวด
บัญชขีองระบบจัดซือ้ทีไ่ดม้กีารเปิดใช ้

งานแลว้  

*  

  

- บันทกึขอ้มูล    เพือ่ใหไ้ดเ้ลขที ่Requisition 

- บันทกึ Line 2 และ Distribution (ถา้ม)ี และท าการ  

 
 

4. Manage Tax 

 
Oracle Menu Path: (N) → Tools → Manage Tax 

 

เมือ่ไดเ้ลขที ่Requisition แลว้ ปุ่ ม Tools Manage Tax จะสวา่ง ใหส้ามารถระบ ุTax Code ได ้จะตอ้งมกีารระบ ุTax Code 
กอ่นทีจ่ะมกีารกดปุ่ ม Calculate Vat เนื่องจากแตล่ะ Line ตอ้งม ีTax Code ปุ่ ม Calculate Vat ถงึจะท างานให ้โดยการ

ค านวณ Vat Amount แลว้มาเปลีย่นค่าทีฟิ่ลด ์Price Inc Vat ใหอั้ตโนมัต ิ
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ใหก้ดปุ่ ม Additional Tax Information  
 

 
 

ระบใุส ่Tax Classification Code ในแตล่ะ Line 
 

 
 

ล าดับ ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

27 Taxation 
Country 

ระบเุป็น Thailand *  

28 Tax 

Classification 
Code 

ระบ ุTax Code ในแตล่ะ Line ใหค้รบ

ทกุ Line 
 

  

 
แลว้กดปุ่ ม Apply ระบบจะค านวณ Tax Amount ในหนา้จอนี้ใหก้อ่น แลว้ปิดหนา้จอ X กลับมาทีห่นา้จอ Requisition 
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5. กดปุ่ ม Calculate Vat 

เมือ่ไดท้ าการใส ่Vat Code แลว้ คอ่ยมา กดปุ่ ม Calculate Vat 
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ระบบจะค านวณ Vat Amount แสดงในฟิลด ์Price Inc.Vat  (Price+Vat Amount) 
 

 
 

 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

29 Price Inc Vat ราคาต่อหน่วยรวม เชน่ ราคา Price = 

Line 1 = 2030 Vat 7%= 142.1 
(2030+142.1 = 2172.1) 

Line 2=  2060 Vat 7%= 144.2 
(2060+144.2 =2204.2) 

*  

 

 

- บันทกึขอ้มูล     
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3. Requisition (การออกใบขอซือ้) กรณี BU Non Vat Requisitions 

 
Oracle Menu Path: (N) → Requisitions → BU Non Vat Requisitions (B) Open  

 

วตัถปุระสงค ์ 
 

เป็นหนา้จอในการออกใบขอซือ้กรณีทีไ่มม่ ีVat ซึง่เป็นหนา้จอทีม่กีาร Custom เดมิ เพือ่ใชใ้นการออกใบขอซือ้ได ้

 
Requisitions Windows 
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1. Requisition Header Zone 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Operating 
Unit 

ระบบจะแสดงขอ้มลูของ Operating 
Unit ตาม Responsibility ทีใ่ชง้าน 

* ไมต่อ้งแกไ้ขใชค้่า Default ที่
ระบบแสดง 

2 Number ระบเุลขทีข่อง Requisition ระบบจะให ้

เลขที ่หลังจากมกีารบันทกึขอ้มลูและ
ท าการ Save แลว้ 

* ปัจจุบันมกีารSetup ใหร้ะบบท า

การ Generate Requisition 
Number ใหเ้ป็นแบบอัตโนมัต ิ 

3 Type Purchase Requisition  เป็นใบแสดง
ความตอ้งการซือ้จาก supplier  

*  

4 Preparer เป็นชือ่พนักงานทีจั่ดท า Requisition 

ทีผู่กกับ User Logon ซึง่ระบบจะ
แสดงใหอั้ตโนมัต ิไมส่ามารถแกไ้ขได ้

*  

5 Description ใสร่ายละเอยีดของใบขอซือ้ไดต้าม

ตอ้งการ ระบุได ้250 ตัวอักษร เพือ่
ประโยชนใ์นการ Group ขอ้มลูแสดง

ในรายงาน CUP BG02 GROUP 

History for PR 

*  

6 Status เป็นการแสดงสถานะของ Requisition 

ซึง่ระบบจะแสดง  Status ครัง้แรกเป็น 
Incomplete  

-   Incomplete: เป็นสถานะเริม่แรก 

-   In Process: หมายถงึเอกสารอยู่
ในระหวา่งทีส่ง่ไปใหผู้ม้อี านาจอนุมัติ

ท าการอนุมัต ิ
-   Approve, Reserved: หมายถงึ

เอกสารไดผ้่านการอนุมัตแิลว้และจอง

งบประมาณ (Budget) แลว้ 
-   Reject: หมายถงึเอกสารไดถ้กู

ผูอ้นุมัตติคีนืกลับมา ซึง่ผูใ้ชจ้ะตอ้ง
แกไ้ขใหมแ่ลว้สง่ใหอ้นุมัตใิหม่อกีครัง้ 

-  Return: หมายถงึใบขอซือ้นี้ไดถ้กู 
Return จากผูจั้ดท าใบสัง่ซือ้ในระบบ 

ใหก้ลับมาท าการแกไ้ขใหมแ่ลว้สง่ให ้

ผูอ้นุมัตใิหม่อกีครัง้ เมือ่ผ่านการอนุมัติ

* 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

เพือ่สามารถน ามาจัดท าเป็นใบสัง่ซือ้  
- Cancelled: หมายถงึ ใบขอซือ้นี้ได ้

ถกูยกเลกิ        

7 Total เป็นยอดเงนิรวมทัง้หมดของใบขอซือ้
ซึง่ระบบจะ Update ใหอั้ตโนมัต ิ

* 
 

 

8 Descriptive 
Flexfield 

ใหร้ะบขุอ้มลูเพิม่เตมิ โดยมขีอ้มลูที่
ตอ้งระบดุังนี้ 

- วันทีข่องเอกสาร (วันทีใ่บเสนอราคา) 

- ใชจ่้ายจากงบปี 
- จัดซือ้จัดจา้งจาก 

- ก าหนดแลว้เสร็จ (วัน) 
- วธิกีารซือ้/จา้ง 

- ค าอธบิายประกอบ 

- ประธานกรรมการตรวจรับ 
- กรรมการและเลขานุการ 

- กรรมการตรวจรับ 1 
- กรรมการตรวจรับ 2 

- กรรมการตรวจรับ 3 

- กรรมการตรวจรับ 4 
- กรรมการตรวจรับ 5 

- กรรมการตรวจรับ 6 
- กรรมการตรวจรับ 7 

* 
 

 

 

 
2. Requisition Lines Zone 

 
บนัทกึขอ้มลูดงันี ้

 

Lines Tab Region 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Num Line บรรทัด ระบบจะสรา้งใหอั้ตโนมัต ิ *  

2 Type ระบบจะแสดงใหอั้ตโนมัต ิเป็น Good *  

3 Item บันทกึสนิคา้ทีต่อ้งการขอซือ้ตาม
ตอ้งการโดยเลอืกจาก List of Value 

วธิกีารเลอืก Item ใส ่% แลว้กดปุ่ ม 
OK หรอืถา้รูว้า่ Item นี้ข ึน้ตน้ดว้ย 05 ก็

สามารถระบุ 05% แลว้กดปุ่ ม OK 

เพือ่ใหร้ะบบแสดง Item ใหเ้ลอืกใส ่

* 

 

 

4 Revision   เป็น Revision ของ Item   

5 Category ระบบจะแสดง Category ของ Item ที่

เลอืก 

* 
 

 

6 Description ระบบแสดดงตาม Description ตาม 

Item ทีก่ าหนด แลว้ท าการแกไ้ขกรณี
ที ่Description ไมต่รงกับความตอ้งการ 

* 
 

 

7 UOM หน่วยนับ *  

8 Quantity 

 

บันทกึจ านวนสนิคา้ทีต่อ้งการขอซือ้ 

 

* 
 

 

9 Price ระบรุาคาต่อหน่วยของสนิคา้ Line นัน้ *  

10 Price Inc Vat ระบบแสดงราคาตอ่หน่วยของสนิคา้ 

Line นัน้ตาม Price ใหอั้ตโนมัตกิอ่น 
หลังจากทีม่กีารระบจุ านวน Vat ใน 

Outstanding แลว้กดปุ่ ม Check แลว้
ระบบจะเปลีย่นคา่ใหเ้ป็น Price + Vat 

Line นัน้ 

* 
 

 

11 Need By  Date ใสวั่นทีต่อ้งการสนิคา้   

12 Amount ระบบจะท าการค านวณใหอั้ตโนมัต ิ

โดยน า Quantity คณูกับ Price 

* 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

13 Destination 

Type 

ระบบจะแสดงตาม Item ทีเ่ลอืกให ้

โดยอัตโนมัตเิป็น Expense หรอื 

Inventory 

* Item ขึน้ตน้ดว้ย 

01% เป็น Expense 

04% เป็น Inventory 
05% เป็น Expense 

14 Requestor ระบบจะแสดงใหเ้ป็น Default ตาม 
Employee ทีไ่ดผ้กูไวกั้บ User Log 

on ให ้

*  

15 Organization บันทกึ Organization ทีท่ าการขอซือ้
สนิคา้ 

*  

16 Location บันทกึสถานทีท่ีต่อ้งการใหส้ง่สนิคา้ 

(Location ของ Organization) 

*  

17 Subinventory  ถา้ตอ้งการระบุ Subinventory ทีจ่ะท า

การรับของ 

  

18 Source ระบบจะแสดงใหอั้ตโนมัต ิเป็น 
Supplier 

*  

19 Supplier ถา้มกีารก าหนด Setup Sourcing 

Rule  ระบบจะแสดง Supplier ให ้
ทันทเีมือ่มกีารเลอืก Item หรอืบันทกึ

ชือ่ Supplier ทีจ่ะท าการสัง่ซือ้สนิคา้  

 ไมต่อ้งใสท่ี ่PR ไปใสต่อนสรา้ง 

PO 

20 Site ตอ้งบันทกึ Supplier Site (ถา้มกีาร
ระบชุือ่ Supplier)  เพราะว่าถา้ไมร่ะบ ุ

Supplier Site เมือ่มกีารน าใบขอซือ้ 
ไปท าการ Auto Create เป็น PO 

ระบบจะไม่แสดงชือ่ Supplier ใน

หนา้จอ PO ให ้

 ไมต่อ้งใสท่ี ่PR ไปใสต่อนสรา้ง 
PO 
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Source Details Tab Region 

 

 
 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

21 Note to Buyer  บันทกึ Note to Buyer หากตอ้งการ

แจง้อะไรใหผู้จั้ดท าใบสัง่ซือ้ทราบ 

  

22 Buyer ถา้มกีารระบุชือ่ Buyer (ซึง่จะเป็นชือ่
ของพนักงาน) แสดงว่าตอ้งการใหช้ือ่

นี้จัดท าใบสัง่ซือ้สนิคา้ให ้  

  

 
 

3. Requisition Distribution Zone 
 
Oracle Menu Path: (N) → Requistiions → Requisitions → (B) Distributions 

 

จากหนา้จอ Requisition Click ทีปุ่่ ม Distributions เพือ่บันทกึ Charge Account ทีจ่ะบันทกึบัญช ี
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

23 Num ระบบแสดงบรรทัดที ่ *  

24 Quantity ระบบแสดงอัตโนมัต ิ *  

25 Charge 
Account 

ระบบจะท าการ Generate Account ที่
จะบันทกึบัญชใีหอั้ตโนมัต ิตามทีม่กีาร

สรา้งมาจาก Item ซึง่บัญชนีี้จะเป็น

บัญชทีีจ่ะไปตัดงบประมาณ (Budget) 
ในระบบ 

 
หมายเหต:ุ กรณีที ่Item ขึน้ตน้ดว้ย 

04 ซึง่เป็น Item ทีเ่ป็นรหัสสนิคา้ – 

ระบบจะท าการลงบัญชใีหอั้ตโนมัต ิ
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

สว่นกรณีทีเ่ป็น Item ประเภทอืน่ๆ ทาง
ผูบั้นทกึจะตอ้งมกีารแกไ้ขบัญชตีามที่

ไดข้อจากแผนกบัญชมีาใหถู้กตอ้ง 

26 GL Date วันทีท่ีเ่กดิรายการบัญช ีซึง่วันทีท่ี่
สามารถระบุไดจ้ะตอ้งเป็นวันทีใ่นงวด

บัญชขีองระบบจัดซือ้ทีไ่ดม้กีารเปิดใช ้

งานแลว้  

  

 

  

- บันทกึขอ้มูล    เพือ่ใหไ้ดเ้ลขที ่Requisition 

- บันทกึ Line 2 และ Distribution (ถา้ม)ี และท าการ  

 
4. Outstanding Vat และ Check (B) 

 

เมือ่ไดเ้ลขที ่Requisition แลว้ ให ้Findหาเลขที ่โดยกดปุ่ ม     กอ่น  
 

 
 

กรณีทีม่ ีVat แต ่Vat เป็น BU Non Vat ใหร้ะบ ุVat Amount ทัง้หมดในฟิลด ์Outstanding Vat (จากตัวอย่างดูที ่Total = 

30,900 บาท Vat 7% = (7%*30,900=2163)  แลว้กดปุ่ ม Calculate Vat ระบบจะค านวณ Vat Amount แลว้มาเปลีย่น
คา่ทีฟิ่ลด ์Price Inc Vat และ Total ใหอั้ตโนมัต ิ
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ระบบจะค านวณ Vat Amount แลว้มาเปลีย่นค่าทีฟิ่ลด ์Price Inc Vat และ Total ใหอั้ตโนมัต ิ 
 

 
 

- บันทกึขอ้มูล   
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4. การจดัพมิพร์ายงานและคน้หารายการทีป่ระมวลผล (Find Request) 

 
Oracle Menu Path: Menu > View > Request 

 
วตัถปุระสงค ์

เป็นหนา้จอทีใ่ชใ้นการพมิพร์ายงานหรอืตรวจดโูปรแกรมที ่Run ได ้หนา้จอนี้สามารถ  

 
1. Find : เพือ่คน้หาหรอืตรวจดรูายการทีป่ระมวลผลว่า Run เสร็จหรอืยัง 

2. Submit a New Request : กรณีจัดพมิพร์ายงานเดยีว 
3. Submit New Request Set :  กรณีจัดพมิพเ์ป็นชดุรายงาน 1 ชดุรายงานจะมหีลายโปรแกรมหรอืหลาย

รายงานอยูใ่น 1 ชดุ 

  

4.1 Find เพือ่คน้หาหรอืตรวจดรูายการทีป่ระมวลผล 

1. เมือ่เขา้มาระบบจะแสดงหนา้จอ Find Request 
 

 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 My Completed 
Requests 

คน้หารายการทีป่ระมวลผลเสร็จแลว้   

2 My Requests 

In Progress 

คน้หารายการทีอ่ยูร่ะหวา่งการ

ประมวลผล 

  

3 All My 
Requests 

คน้หาทุกรายการ * ระบบจะ Default 

4 Specific 
Requests 

คน้หารายการโดยระบเุงือ่นไข 
Request ID:  เลขทีก่ารประมวลผล 

Name:  ชือ่การประมวลผล 

DateSubmitted:   วันทีส่ัง่ประมวลผล 
Date Completed:  วันทีป่ระมวลผล

 ถา้มกีารระบุ Specific Requests 
ตอ้งระบเุงือ่นไขเพิม่ เชน่ เลขที ่

Request ID แลว้กดปุ่ ม Find 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

เสร็จ 
Status:   สถานะของรายการ 

Phase:   ขัน้ตอนการประมวลผล 
Requestor:   ผูส้ัง่ประมวลผล 

5 Select the 

number of 
Days to view 

จ านวนวันยอ้นหลังทีต่อ้งการคน้หา *  

 

2. แลว้กดปุ่ ม Find ระบบจะแสดงหนา้จอดังนี้ 

 
 

 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Refresh Data กรณีทีม่กีาร Run รายงานการ

ประมวลผลยังไม ่Completed ตอ้งการ 
Manual กดปุ่ ม Refresh Data เพือ่ดู

การเปลีย่นแปลงของการประมวผล 

จนกระท่ังเป็น Completed ซึง่ที ่
Phase เป็น  

Inactive:  ระบบไม่ท างาน ตอ้งแจง้
ผูด้แูลระบบ 

Pending:  รอการประมวลผล 
Running: ก าลังประมวลผล 

Completed:  ประมวลผลเสร็จสิน้ 

* กดปุ่ มเอง 

2 Auto Refresh กรณีทีม่กีาร Run รายงานการ
ประมวลผลยังไม ่Completed ตอ้งการ 

Auto refresh ใหอั้ตโนมัต ิโดยการ

คลิ๊ก √ ทีก่ลอ่งสีเ่หลีย่ม Auto 
Refresh เพือ่ใหร้ะบบท างานอัตโนมัต ิ

ดกูารเปลีย่นแปลงของการประมวผล  

* √ ทีก่ล่องสีเ่หลีย่ม Auto 
Refresh  
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

3 Submit a New 
Request 

ตอ้งการจัดพมิพร์ายงานเดยีวใหม ่ * เมือ่กดเขา้มา ระบบใหเ้ลอืกชือ่
รายงานเดยีวทีต่อ้งการจัดพมิพ์ 

4 Submit a New 

Request Set 

ตอ้งการจัดพมิพร์ายงานชดุใหม ่ * เมือ่กดเขา้มา ระบบใหเ้ลอืกชือ่

รายงานชดุทีต่อ้งการจัดพมิพ์ 

5 Copy Single 

Request 

ตอ้งการจัดพมิพร์ายงานเดยีวใหมโ่ดย

วธิ ีCopy 

* เมือ่กดเขา้มา ระบบให ้Find หา

รายงานเดยีวทีเ่คยจัดพมิพเ์ลอืก 

เพือ่จัดพมิพใ์หม ่

6 Copy Request 

Set 

ตอ้งการจัดพมิพร์ายงานชดุใหมโ่ดยวธิ ี

Copy 

* เมือ่กดเขา้มา ระบบให ้Find หา

รายงานชดุทีเ่คยจัดพมิพเ์ลอืก 
เพือ่จัดพมิพใ์หม ่

 

 

4.2 Submit a New Request : กรณีจดัพมิพร์ายงานเดยีว 

4.2.1 พมิพร์ายงานเดยีว CUP - ใบขอซือ้ (VAT) (เป็น .ps) 

1. ไปทีเ่มนู View > Request ระบบจะแสดงหนา้จอ Find Request ใหก้ดปุ่ ม Submit a New Request 
 

 
 

2.ระบบจะแสดงหนา้จอ Submit Request  ใหเ้ลอืกรายงานที ่Name 
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3.เลอืกรายงาน 1 รายงาน ชือ่วา่ CUP - ใบขอซือ้ (VAT) แลว้ระบ ุparameter 

 

 
3. ระบ ุParameter เป็นเงือ่นไขในการดงึขอ้มลูออกในรายงาน แลว้กด OK กดปุ่ ม Submit 
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4. Request submitted  

(Request ID = 18208869) 

ระบบแสดง Submit another request? 
Yes: ตอ้งการเลอืกรายงานใหมท่ีต่อ้งการอกี 

No: ไมต่อ้งการ 

 
ใหต้อบ No 
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5. ระบบจะแสดงเลขที ่Request ID ทัง้หมด ด ูRequest ID ทีต่อ้งการหรอื Name = CUP - ใบขอซือ้ (VAT)  
จนกระท่ังสถานะเป็น Completed/Normal แลว้กดปุ่ ม View output 

 

 
 

6. ใหS่ave As 

 
7. ระบชุือ่ไฟล ์Type = PostScript (*.ps)  ตอ้งเปิดดว้ยโปรแกรม GSview 
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8. เปิดไฟลด์ว้ย GSview 
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4.3 Submit a New Request Set : กรณีจดัพมิพร์ายงานชุด 

4.3.1 พมิพร์ายงานชุด  

1. ไปทีเ่มนู View > Request ระบบจะแสดงหนา้จอ Find Request ใหก้ดปุ่ ม Submit a New Request Set 
 

 

 
 

2. ระบบจะแสดงหนา้จอ Submit Request Set ใหเ้ลอืกรายงานที ่Name = CUP - ใบขอซือ้ (VAT) (Set)              

และระบ ุParameter แลว้กด OK กดปุ่ ม Submit 
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3. ระบบใหเ้ลขที ่Request ID แสดง Submit another request? 
Yes: ตอ้งการเลอืกรายงานใหมท่ีต่อ้งการอกี 

No: ไมต่อ้งการ 
 

ใหต้อบ No 
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4. ระบบจะแสดงหนา้จอ Find Request แลว้กดปุ่ ม Find 
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5. กดปุ่ ม Refesh Data จนกระท่ัง completed Normal 
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5. สง่รายการบญัชจีากการท ารบัของไปGL(Create Accounting - Cost Management) 

Oracle Menu Path: Menu > View > Request 
 

วตัถปุระสงค ์
เป็นหนา้จอทีใ่ชใ้นสง่รายการบัญชจีากการท าการรับของทัง้ทีเ่ป็น Inventory และ Expense ทัง้ทีท่ าการ Receipt หรอื 

Deliver ของเขา้ Stock แลว้ ไปยังระบบบัญชแียกประเภท 

 
 

 
1. Submit a New Request : Create Accounting - Cost Management แลว้ระบ ุParameters แลว้กด OK 

 

 
 
 

ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

1 Ledger Ledger ทีต่อ้งการ Create Accounting * สว่นบรหิารกจิการสยามสแควรวั์น 

2 Process 

Category 

• Inventory 

• Receiving  

* ไมต่อ้งระบ ุเพือ่ใหร้ันครบทุก 

Process Category 

3 End Date ระบวัุนทีท่ีต่อ้งการ create Accounting 

จนถงึวันนี้เชน่ 20 –JUL-2024 
หมายความวา่ ระบบจะท าการ Create 

Accountingกอ่นวันที ่20 –JUL-2024 
ทัง้หมดทีร่ายการยังไม่ไดถู้ก Create 

Accounting จนถงึวันที ่20 –JUL-2024 

* ระบุวันทีปั่จจุบัน เชน่ 20-JUL-

2024 

4 Mode เลอืก Mode 

• Draft 

• Final 

 Final 

5 Error Only เลอืก Errors Only 

• No 

• Yes 

 No 

6 Report • No: ไมต่อ้งแสดง Output   Detail 
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ล าดบั ชือ่ฟิลด ์ ค าอธบิาย (*) รายละเอยีดเพิม่เตมิ 

• Detail:  ตอ้งการ Output 

แสดงรายละเอยีด 

7 Transfer to GL เลอืก Transfer to General Ledger 

• No: ระบบไม่สง่รายการไปที ่GL 

• Yes: ระบบจะสง่รายการไปที ่

GL ทันท ีจะมโีปรแกรมในสง่ไป

ที ่GL 

 Yes 

8 Post in 

General 

Ledger 

• No:  ระบบจะไมท่ าการ Post 
Journal  ให ้โดยเป็น Unpost 

แลว้ตอ้งไปท าการ Post 

Journal เองทีร่ะบบ GL อกีครัง้ 

• Yes: ระบบจะท าการ Post 
Journal ดว้ย 

* Yes 

9 Inventory 
Organization 

เลอืก Inventory Organization 
 

  

10 Include User 

Transaction 
Identifiers 

เลอืกวา่แสดงขอ้มลูเพิม่เตมิหรอืไม่ 

• No 

• Yes แสดงเลขที ่PR PO ดว้ย 

* Yes 

 

2. กดปุ่ ม Submit 
 

 
3. ระบบใหเ้ลขที ่Request ID ระบบแสดง Submit another request? 

  Yes: ตอ้งการเลอืกรายงานใหมท่ีต่อ้งการอกี 
   No: ไมต่อ้งการ 

 
   ใหต้อบ No 
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4. ระบบจะแสดงหนา้จอ Find Request แลว้กดปุ่ ม 

 
5. กดปุ่ ม Refresh Data หรอื √ Auto Refresh (ใหร้ะบบกดปุ่ ม Refresh ใหอั้ตโนมัต)ิ จนกระท่ังเป็น Completed 

Normal 
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6. View output ของ Create Accounting - Cost Management 
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7. View output ของ Journal Import 

 
8. เลอืก Viewer = Browser  
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9. ระบบจะแสดงผลการสง่ขอ้มูลไป GL และเกดิ Batch Journal อยา่งไร 

 
 

10. Find Batch Journal ทีร่ะบบ GL 

 
 

11. Batch ทีแ่สดง Source = Cost Management เกดิ Category 2 Category 

Category = Inventory คอืรายการทีท่ าการ Deliver เขา้ Stock กรณีที ่Item เป็น Inventory 
Category = Receiving คอืรายการทีท่ าการรับเขา้ Receiving ทัง้ Item ทีเ่ป็น Expense และ Inventory 

และการ Deliver ของเขา้ Expense กรณีที ่Item เป็น Expense 
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12. สามารถน า Cursor วางไวท้ีบ่รรทัดทีต่อ้งการ Drilldown โดยกดปุ่ ม Line Drilldown 

 
 

13. ระบบจะแสดงหนา้จอ View Journal Entry Line สามารถกดปุ่ ม View Transaction ระบบจะแสดงขอ้มูลทีม่าจาก
ตน้ทาง 
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14. กดปุ่ ม View Journal Entry ระบบจะแสดงหนา้จอ Sub ledger Journal Entry ดขูอ้มูล Transaction 

Information-ของขอ้มูลทีม่าจากตน้ทาง 
 

 
 

 


